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Welcome

Congratulations on your purchase of the Novatel Wireless Ovation MC998D USB Modem! Please 
review this manual before installing the MobiLink software and drivers, and before using the device 
for the first time.

Product Overview

Package Contents

The Novatel Wireless Ovation MC998D modem package includes:

 • Ovation MC998D modem

 • Quick Start Guide

System Requirements

 • Supported operating system

 • Windows® XP, Vista, 7

 • Mac OS X® v10.4.x and later

 • Linux® (2.4, 2.6) [Visit www.novatelwireless.com for more information]

 • USB port: Type A, v1.1 supported; v2.0 high speed recommended

 • Hard Drive: minimum 100 MB available

 • Memory: 64 MB RAM

 • Internet browser software: e.g. Microsoft Internet Explorer 6.0 or Higher, Firefox, Safari, 
Opera, Chrome

 • Modem software: MobiLink software included on the device; no CD required

http://www.novatelwireless.com
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Components

➊➊ LED indicator: Indicates the device is working correctly or needs attention; also indicates 
data transmission. [See LED States (page 6).].

➊➋ SIM card slot: (Not shown; under the removable plastic panel.) Holds the SIM card from your 
network operator. 

➊➌ microSDHC slot: (Not shown; under the removable plastic panel.) When a microSDHC card 
is inserted, this feature enables you to store files on the device and transfer files to another 
device or computer. 

➊➍ Hinged USB connector: Allows the device to rotate as needed. 
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LED States

Ovation MC998D’s LED indicates the status of the current connection.

LED color Device Status LED Status Description

No Light No Power  — The device is powered off

BLUE/
GREEN

Alternating Searching for service

GREEN GPRS/EDGE Flashing:

Solid:

GPRS/EDGE service is available

Connected to a network using GPRS/EDGE

BLUE UMTS Flashing: 

Solid:

UMTS service is available

Connected to a network using UMTS

VIOLET HSPA Flashing:

Solid: 

HSPA service is available

Connected to a network using HSPA

YELLOW HSPA+ Flashing:

Solid: 

HSPA+ service is available

Connected to a network using HSPA+

RED Error Solid: Device error
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Caring for Your Device

Like any electronic device, the modem must be handled with care to ensure reliable operation. 
Novatel Wireless recommends the following guidelines:

 • Do not apply adhesive labels to the device; they might cause the device to potentially 
overheat and they might alter the performance of the antenna.

 • The USB connector should plug easily into your computer’s standard Type A USB port. Do not 
force the device into a port, as doing so might damage the connector. 

 • Protect the device from liquids, dust, and excessive heat. 

 • Store the device in a safe place when not in use.
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Using the Device for the First Time

IMPORTANT Do not insert Ovation MC998D into a USB hub, as it might not provide sufficient 
power.

Insert the SIM Card

IMPORTANT To use Ovation MC998D, you must have an account with a network operator.
 
Some network operators might require account activation. If so, your network operator should 
have provided activation instructions. If your account needs to be activated and instructions 
were not provided, contact your network operator for complete instructions.

Before your first use of Ovation MC998D, you must install the SIM card supplied by your network 
operator. 

➊➊ Remove the cover on the bottom of the device.

➊➋ Orient the SIM card with the cut corner away from the SIM slot and with the metal contacts 
on the card facing the metal contacts in the device.

➊➌ Push the SIM card all the way into the slot.

➊➍ Replace the cover.
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Properly Insert the Device in Your Computer

To properly insert the device

➊➤ Gently flip open the USB connector. Hold the device along the side edges and gently insert the 
device into your computer’s Type A USB port. Ovation MC998D should fit easily into the port. 
Do not force the device into the port as this might damage both the device and the port.

 NOTE 	 If	you	have	difficulty	inserting	the	device	into	your	computer’s	USB	port,	verify	that	you	are	inserting	
the	device	in	the	correct	orientation	and	you	are	using	a	Type	A	USB	port.

Install the MobiLink Software

IMPORTANT Do not insert Ovation MC998D into a USB hub, as it might not provide sufficient 
power.

MobiLink is a multi-platform application for Windows and Mac OS X. The operating systems connect 
to the network using the MobiLink connection manager.

Ovation MC998D includes the MobiLink software in its flash memory, so no installation CD is 
needed. The first time you insert the device in the computer, the following occurs:

 • On Windows, Ovation MC998D automatically installs MobiLink.

 • On Mac OS X, Ovation MC998D opens a Finder window with an installer package.

To install the MobiLink software

 NOTE 	 Mac	users	need	to	re-start	the	computer	to	complete	the	installation.

➊➊ Turn on your computer and close all applications.

➊➋ Insert Ovation MC998D into your computer’s USB port. [See To properly insert the device 
(page 10).]

	» Windows	users:	The	installation	program	launches	automatically.

	» Mac	users:	A	Finder	window	opens	to	show	a	package	icon.	Double-click	the	icon	to	launch	the	
installer.

➊➌ Follow the onscreen instructions.
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➊➍ Mac users need to re-start the computer and then open MobiLink in the Applications folder.

 Tip! 	 Mac	users:	The	MobiLink	Dock	icon	is	a	convenient	way	to	open	the	software	if	you	keep	it	in	the	
Dock.	After	MobiLink	is	open,	click	and	hold	the	MobiLink	icon	until	the	Dock	icon	menu	opens,	and	
then	select	Keep in Dock	(Tiger	and	Leopard)	or	Options	>	Keep in Dock	(Snow	Leopard)
You	can	also	select	Open at Login	in	the	Dock	icon	menu.

After Installation is Complete

Windows users: After installation completes, Windows users see the following:

 • A MobiLink shortcut is placed on the desktop

 • A MobiLink status icon appears in the system tray 
(Windows notification area)

 • The MobiLink connection manager window opens

Mac users: After the computer re-starts and the MobiLink application is open, Mac users see the 
following:

 • A MobiLink icon is placed in the Dock

 • A MobiLink status icon appears on the right side of the 
menu bar

 • The MobiLink connection manager window opens

 Tip! 	 Mac	users:	The	MobiLink	Dock	icon	is	a	convenient	way	to	open	the	software	if	you	keep	it	in	the	
Dock.	After	MobiLink	is	open,	click	and	hold	the	MobiLink	icon	until	the	Dock	icon	menu	opens,	and	
then	select	Keep in Dock	(Tiger	and	Leopard)	or	Options	>	Keep in Dock	(Snow	Leopard).

Activation

Some accounts might require activation from your network operator.

If the MobiLink connection manager says Device is not activated, click the Activation button and 
follow the onscreen instructions.
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Using a microSDHC™ Card

microSDHC cards are available for Ovation MC998D, sold separately through Novatel Wireless 
partners.

microSDHC slot

Ovation MC998D is equipped with removable, hot-swappable, memory storage. This feature 
enables you to simultaneously connect to the Internet, access your corporate VPN on the fly, and 
store data on Ovation MC998D without needing another flash drive.

A microSDHC card (sold separately) is required to take advantage of the memory storage feature 
and is available in high-capacity sizes.

Inserting and removing a microSDHC card

To insert a microSDHC card

➊➊ Locate the microSDHC slot as depicted in the figure below.

➊➋ Line up the microSDHC card with the slot as shown.

➊➌ Gently push in the microSDHC card until it is firmly seated.
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To remove a microSDHC card

➊➤ Gently grip the microSDHC card, and then pull it straight out.

Saving files to microSDHCHC

The process of saving files to the microSDHCHC memory card is similar to saving files to any external 
flash drive inserted in your computer. A microSDHC card with sufficient free space must be inserted 
in Ovation MC998D. To ensure that Ovation MC998D is properly inserted, [See To properly insert the 
device (page 10).].

To download files directly to Ovation MC998D

➊➊ In the Save to box, click the down arrow to view the contents of the drop-down menu.

➊➋ Select Ovation MC998D, which typically appears as a removable storage device with an 
assigned drive letter as identification.

➊➌ Type a name for the file you are saving to Ovation MC998D and click Save.

To save files from an application

➊➊ When saving files directly from an application to Ovation MC998D, go to File > Save As. In the 
Save As window, click the down arrow.

➊➋ In Windows Explorer, select Ovation MC998D, which typically appears as a removable storage 
device with an assigned drive letter as identification. 
In the Mac Finder, select Ovation MC998D from the Devices list on the left side of the Finder 
window.

➊➌ In the Save As field, type a name for the file you are saving to Ovation MC998D and then 
click Save.

To drag/drop – copy/paste

➊➊ In Windows Explorer, locate Ovation MC998D as a removable storage device with an 
assigned drive letter as identification. 
In a Mac Finder window, locate Ovation MC998D under Devices on the left side of the Finder 
window, or as a disk image on the desktop.

➊➋ Double-click Ovation MC998D to open a window and view the contents.

➊➌ Drag or paste files into the Ovation MC998D window.

To open files from the microSDHC card

➊➊ In Windows Explorer, locate Ovation MC998D as a removable storage device with an 
assigned drive letter as identification. 
In a Mac Finder window, locate Ovation MC998D under Devices on the left side of the Finder 
window, or as a disk image on the desktop.

➊➋ Double-click Ovation MC998D to open a window and view the contents.

➊➌ Double-click to open the file.
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Overview

When properly installed, Ovation MC998D is a highly reliable product. Most problems are caused by 
one of these issues.

 • System resources required by the modem are being used by other devices.

 • Network coverage is unavailable due to coverage area, an account problem, or a network 
problem.

The following tips can help solve many common problems encountered while using Ovation 
MC998D.

First Steps

 • Make sure you are using the device in the correct geographic region.

 • Ensure that your network operator’s wireless coverage extends to your current location.

 • Ensure you have an active subscription plan from your network operator.

 • Restarting your computer and your modem can resolve many issues.

IMPORTANT Before contacting support, be sure to re-start both your computer and Ovation 
MC998D.
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Common Problems and Solutions

The following are some common problems and solutions.

My computer does not start when the device is inserted. I experience an error 
or a blank screen.

➊➤ When this happens, remove the device and re-start the computer. 
The device contains internal memory which behaves like a CD-ROM. Some computers, 
depending on the system BIOS settings, might try to start from the device’s internal memory 
instead of the Hard Drive. The computer might show a black screen with a cursor or an error 
message about a non-bootable disk. This behavior is similar to using any non-bootable CD in 
your CD-ROM drive.

I cannot install the software
➊➤ You might not have administrator privileges.

1. Contact your system administrator (if applicable).

2. Log on to your computer as an administrator, or create a user account with administrator 
privileges.

I still cannot connect to the network after trying First Steps [See First Steps (page 

15).]
➊➤ The software might be incorrectly installed. Check that you have correctly installed the 

software located on the device.

➊➤ Your Connection Type in the active connection profile might be incorrect. Use the Profile 
Manager to verify your settings.

➊➤ Your access point name (APN) settings, username, or password in the active connection profile 
might be incorrect. Use the Profile Manager to verify your settings.



17

Support

IMPORTANT Before contacting support, be sure to re-start both your computer and Ovation 
MC998D.

For more information about your device, please visit www.novatelwireless.com.

http://www.novatelwireless.com
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Product Specifications

Data Speeds

 • HSPA+ downlink Cat 14 (21.6 Mbps). Firmware upgradable to Cat 18 (28.8 Mbps)

 • HSPA+ uplink Cat 6 (5.76 Mbps). Firmware upgradable to Cat 7 (11.5 Mbps)

 • HSDPA downlink Cat 8 (7.2 Mbps)

 • HSDPA uplink Cat 6 (5.76 Mbps)

Advanced Technologies

 • 2 x 2 MIMO — Enables industry-leading data speeds

 • Receiver Equalization — Improves performance in noisy and highly mobile environments

 • Receiver Diversity — Improves performance at cell edges and in buildings

Power Class

 • WCDMA 900/2100 — Power Class 3

 • GPRS 1800/1900 — Power Class 1

 • GPRS 850/900 — Power Class 4

 • EDGE 850/900/1800/1900 — Power Class E2

Dimensions and Weight

 • 76.9mm x 41.6mm x 11.9mm (LxWxH)

 • 24g

Form Factor

 • USB Dongle

 • USIM card slot (card size: 25 mm x 15 mm)

Embedded Installer, no CD

 • MobiLink software is embedded in flash memory for Windows and Mac.

Data Storage

 • The device supports microSDHC cards up to 32GB.



20

Regulatory Statements

CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union 
and has attained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. 
The CE Mark applies to products regulated by certain European health, safety and environmental 
protection legislation. The CE Mark is obligatory for products it applies to: the manufacturer affixes 
the marking in order to be allowed to sell his product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to 
attain CE Marking. A notified body has determined that this device has properly demonstrated that 
the requirements of the directive have been met and has issued a favorable certificate of expert 
opinion. As such the device will bear the notified body number 0682 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a 
product.

Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are 
voluntary. 

Marking: The product shall bear the CE mark, the notified body number(s) as depicted on this page.
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Federal Communications Commission Notice (FCC – United States)

This equipment has been tested to, and found to be within the acceptable limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules and Industry Canada ICES-003. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a residential 
environment. This equipment generates radio frequency energy and is designed for use in accordance 
with the manufacturer’s user manual. However, there is no guarantee that interference will not occur in 
any particular installation. If this equipment causes harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, you are encouraged to try to correct the 
interference by one or more of the following measures. 

• Reorient or relocate the receiving antenna

• Increase the separation between the equipment and the receiver

• Consult the dealer or an experienced radio/television technician for help

This device complies with Part 15 of the Federal Communications Commission (FCC) Rules and Industry 
Canada ICES-003. Operation is subject to the following two conditions:

• This device may not cause harmful interference.

• This device must accept any interference received, including interference that may cause undesired 
operation.

WARNING: DO NOT ATTEMPT TO SERVICE THE WIRELESS COMMUNICATION DEVICE YOURSELF. SUCH ACTION 
MAY VOID THE WARRANTY. THE OVATION DEVICE IS FACTORY TUNED. NO CUSTOMER CALIBRATION OR TUNING 
IS REQUIRED. CONTACT YOUR SERVICE PROVIDER FOR INFORMATION ABOUT SERVICING YOUR WIRELESS 
COMMUNICATION DEVICE.

NOTE: The Radio Frequency (RF) emitter installed in your modem must not be located or operated in 
conjunction with any other antenna or transmitter, unless specifically authorized by Novatel Wireless 
Technologies.

MODIFICATIONS: Any changes or modification not expressly approved by Novatel Wireless, Inc. could 
void the user’s authority to operate this equipment. The FCC has granted an Equipment Authorization for 
this wireless modem with all reported SAR levels evaluated as in compliance with the FCC RF exposure 
guidelines. 

FCC Equipment Authorization ID: NBZNRM-MC998D

In order to comply with FCC RF exposure requirements, the device must be installed so that a minimum 
separation distance of 0.5 cm (0.2”) is maintained between the antenna and all persons during ordinary 
operating condition.
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Wireless Communications

IMPORTANT Due to the transmission and reception properties of wireless communications, 
data occasionally can be lost or delayed. 

Data loss or delay can be caused by variation in radio signal strength that results from changes in 
the characteristics of the radio transmission path. Although data loss is rare, the environment where 
you operate the modem may adversely affect communications.

Novatel Wireless or its partners will not be held responsible for damages of any kind resulting from 
the delays or errors in data transmitted or received with Ovation MC998D, or failure of Ovation 
MC998D to transmit or receive such data.

Limited Warranty and Liability

Novatel Wireless warrants for the 12 month period immediately following receipt of the Product by 
Purchaser that the Product will be free from defects in material and workmanship under normal use.  THESE 
WARRANTIES ARE EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. 

The exclusive remedy for a claim under this warranty shall be limited to the repair or replacement, at 
Novatel Wireless’ option, of defective or non-conforming materials, parts or components.  The foregoing 
warranties do not extend to (I) non conformities, defects or errors in the Products due to accident, abuse, 
misuse or negligent use of the Products or use in other than a normal and customary manner, environmental 
conditions not conforming to Novatel Wireless’ specification, of failure to follow prescribed installation, 
operating and maintenance procedures, (II) defects, errors or nonconformity’s in the Product due to 
modifications, alterations, additions or changes not made in accordance with Novatel Wireless’ specifications 
or authorized by Novatel Wireless, (III) normal wear and tear, (IV) damage caused by force of nature or 
act of any third person, (V) shipping damage, (VI) service or repair of Product by the purchaser without 
prior written consent from Novatel Wireless, (VII) products designated by Novatel Wireless as beta site test 
samples, experimental, developmental, reproduction, sample, incomplete or out of specification Products, or 
(VIII) returned products if the original identification marks have been removed or altered.
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Safety Hazards

Do not operate Ovation MC998D in an environment that may be susceptible to radio interference 
resulting in danger, specifically:

Areas where prohibited by the law 

Follow any special rules and regulations and obey all signs and notices. Always turn off the host 
device and remove Ovation MC998D from the computer when instructed to do so, or when you 
suspect that it may cause interference or danger.

Where explosive atmospheres may be present 

Do not operate Ovation MC998D in any area where a potentially explosive atmosphere may exist. 
Sparks in such areas could cause an explosion or fire resulting in bodily injury or even death. Be 
aware and comply with all signs and instructions.

Users are advised not to operate Ovation MC998D while at a refueling point or service station. Users 
are reminded to observe restrictions on the use of radio equipment in fuel depots (fuel storage and 
distribution areas), chemical plants, or where blasting operations are in progress.

Areas with a potentially explosive atmosphere are often but not always clearly marked. Potential 
locations can include gas stations, below deck on boats, chemical transfer or storage facilities, 
vehicles using liquefied petroleum gas (such as propane or butane), areas where the air contains 
chemicals or particles, such as grain, dust or metal powders, and any other area where you would 
normally be advised to turn off your vehicle engine.

Near Medical and life support equipment

Do not operate Ovation MC998D in any area near medical equipment or life support equipment, 
or near any equipment that may be susceptible to any form of radio interference. In such areas, the 
host communications device must be turned off. Ovation MC998D may transmit signals that could 
interfere with this equipment.

On an aircraft, either on the ground or airborne

In addition to FAA requirements, many airline regulations state that you must suspend wireless 
operations before boarding an airplane. Please ensure that the host device is turned off and your 
Ovation MC998D is removed from the computer prior to boarding aircraft in order to comply with 
these regulations. Ovation MC998D can transmit signals that could interfere with various onboard 
systems and controls.
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While operating a vehicle

The driver or operator of any vehicle should not operate a wireless data device while in control of 
a vehicle. Doing so detracts from the driver or operator’s control and operation of that vehicle. In 
some countries, operating such communications devices while in control of a vehicle is an offense.

Electrostatic Discharge (ESD)

Electrical and electronic devices are sensitive to electrostatic discharge (ESD). Macintosh native 
connection software may attempt to reinitialize the device should a substantial electrostatic 
discharge reset the device. If the software is not operational after an ESD occurrence, then restart 
your computer.
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Glossary

➊● APN — Access point name.

➊● bps — Bits per second–rate of data flow.

➊● Broadband — High-capacity high-speed, transmission channel with a wider bandwidth than 
conventional modem lines. Broadband channels can carry video, voice, and data simultaneously. 

➊● EDGE — Enhanced Data Rates for GSM Evolution. EDGE is a wireless broadband technology with an 
average speed of 400 kbps. 

➊● Firewall — A hardware or software boundary that protects a network or single computer from 
unwanted outside traffic.

➊● GPRS — General Packet Radio Service. GPRS is a wireless broadband technology with speeds from 56-
114 kbps.

➊● Hot-Swappable — The ability to remove and replace the microSDHC card from the device while it is 
still connected to the computer and online without damaging the device.

➊● HSDPA — High Speed Downlink Packet Access. HSDPA is an enhanced version of WCDMA that 
supports broadband connections with download speeds up to 7.2 Mbps. This enhanced 3G 
technology enables the download of high-bandwidth multimedia files, high resolution graphics, and 
other complex files, and viewing email attachments at broadband-like speeds. 

➊● HSPA+ — HSPA Evolution or HSPA Evolved. A 3G mobile telephony protocol with up-link speeds up to 
11 Mbps and downlink speeds up to 42 Mbps.

➊● HSUPA — High Speed Uplink Packet Access. A 3G mobile telephony protocol with data rates of 7.2 
Mbps downlink and 5.76 Mbps uplink. 

➊● IP — Internet Protocol. The mechanism by which packets are routed between computers on a 
network.

➊● ISP — Internet Service Provider. Also referred to as the service carrier, an ISP provides Internet 
connection service.

➊● Kbps — Kilobits per second–rate of data flow. 

➊● LAN — Local Area Network. A data network confined to limited area with moderate to high data rates. 
Does not use common carrier circuits, although may have gateways or bridges to other public or 
private networks.

➊● Mbps — Megabits per second.

➊● MicroSDHC  — Additional external memory for your device.

➊● MicroSDHC Card — A small, removable flash memory card available in various storage sizes. This 
accessory is sold separately.

➊● MicroSDHC Slot — A built-in slot on your device that is designed specifically for a microSDHC card.

➊● PDA — Personal Digital Assistant. A handheld device used for organization, notes, address books, etc.
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➊● PPP — Point-to-Point Protocol. A method of connecting a computer to the Internet.

➊● Proxy — A firewall mechanism that replaces the IP address of a host on the internal (protected) 
network with its own IP address for all traffic passing through it.

➊● SMS — Short Messaging Service. Short text messages of up to 160 characters sent and received by 
wireless devices.

➊● TCP/IP — Transmission Control Protocol/Internet Protocol. The set of communications protocols used 
for Internet and other similar protocols.

➊● Type A USB — The USB ports on computers and hubs have a rectangular Type A socket, and 
peripheral devices have a cable with a Type A plug. Peripherals that do not have an attached cable 
have a square Type B socket on the device and a separate cable with a Type A and Type B plug.

➊● UMTS — Universal Mobile Telecommunications Service. A third-generation broadband, packet-based 
transmission of text, digitized voice, video and multimedia at data rates up to 2 Mbps. UMTS offers 
a consistent set of services to mobile users all over the world. UMTS is based on the GSM standard. 
Until UMTS is fully implemented, users can use multi-mode devices that switch to currently available 
technology.

➊● USB — Universal Serial Bus. A connection type for computing device peripherals such as a printer, 
mobile broadband modem, etc. USB can be found in versions 1.1 and 2.0. They are further split into 
speed categories: Low-Speed, Full-Speed, and High-Speed (v2.0 only). To make use of the maximum 
speed of the device, v2.0 High-Speed is required. Check your computer to see what version is fitted. 
The device will work on Full-Speed connections, but will be unable to operate at peak rates.

➊● VPN — Virtual Private Network. A way to communicate through a dedicated server securely to a 
corporate network over the Internet.

➊● WAN — Wide Area Network (WAN). A computer network covering a broad geographical area. WANs 
are used to connect local area networks (LANs) together, so that users and computers in one location 
can communicate with users and computers in other locations.

➊● WCDMA — Wideband Code Division Multiple Access. A 3G mobile wireless technology that promises 
much higher data speeds to mobile and portable wireless devices. Another name for UMTS. 

➊● WWAN — Wireless Wide Area Network (WWAN). Also called “wireless broadband” or “broadband 
wireless,” wireless WANs (WWANs) use cellular towers to transmit a wireless signal over a range of 
several miles to a mobile device compared to wireless Wi-Fi LANs (WLANs), which span only a few 
hundred feet and generally to only stationary devices.
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